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1. Introduction

1.1. FMI Connection for NI VeriStand

The FMI Connection for NI VeriStand allows you to use FMU model on NI
VeriStand.




2. Installation

2.1. Supported Platforms

The FMI Connection for NI VeriStand is supported on Windows XP(32 bit),
Windows Vista (32 bit) and Windows 7 (32 bit).

2.2. Installation Procedure

1. Run the installer by double-clicking FMItoNIVS_x.x.x.exe , and click Next on
welcome page.

¥ Setup - FMU to VeriStand Connection 2011 E]

Welcome to the FMU to VeriStand
Connection 2011 Setup Wizard

This will install FrU bo YeriStand Connection 2011 wersion 1.1
on your computer,

It is recommended that vou close all other applications before
conkinuing,

Click Mext to continue, or Cancel to exit Setup,

[ et = l[ Cancel ]

Figure 2.1 First installer dialog, welcome text.

2. Read the license agreement, and click | Agree to agree to the terms and continue.




-

Jas Setup - FMU to VeriStand Connection 2011 E]

License Agreement
Please read the Following important information before continuing.

=

Please read the Following License Agreement. You must accepk the terms of this
agreement before continuing with the installation,

DOFWARE
TEMPORARY END-USER LICENSE AGREEMENT 2012

PLEASE READ CARFFULLY BEFORE USING THIS FOUIPIMENT: This End-
User License Agreement ("EULA"™) iz a legal agreement between (4) you
(either an individual or a single entity) and (b) Dofware Jrl that governs
wour use of any Software Product, installed on or made available by Dofieare.

OI accept the agreement

(%) 1 do not accept the agreement

Figure 2.2 Second installer dialog, license agreement

3. Choose the directory where the FMI Connection should be installed. The default
installation directory, which will be pre-selected, is C:\Program
Files\FMUtoNIVS. If you use more than one VeriStand version, | suggest to
change this name folder. For example if you use NI VeriStand 2011, | suggest to
install the connection in C:\Program Files\FMUtoNIVS2011.

[l Setup - FMU to VeriStand Connection 2011 g

Select Destination Location
Where should FMU to YeriSkand Connection 2011 be installed?

e

./-} Setup will install FMU to WeriStand Connection 2011 into the Followwing Folder.

To continue, click Mext, IF vou would like to select a different folder, click Browse,

C:\ProgrammilFMULoNIYS201 1

At least 20,5 MB of Free disk space is required,

< Back “ Mext = ][ Cancel

Figure 2.3 Third installer dialog, select installation folder.

4. Select Install if you are ready to start the installation. Select Back to redo the last
step.




5. After the installation has completed you will find a folder created for the FMI
Connection in the Windows Start menu and click on it folder you can view
folders show below:

Inditizza |Lf) :\Program FilesiFMUtohIVS [v] Yai

Documentation
Examples
external

License

Readme. bzt
Diocumnento di kesto
1KB

S unins000, dat
File DAT
& KB

unins000. exe
SetupfUninstal

Figure 2.4 FMI Connection folder.




3. License file installation

After the installation procedure, FMI Connection will be in demo mode. To use the
program fully, a license file must be installed. After purchasing a license, you should
receive a file named license.lic. Place that file in the \FMUtoNIVS\License directory
that is found in the \Program Files on Windows x86 and \Program Files (x86)

on Windows x64.
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4. Install FMI Add-on in NI RT-Target

Open the Measurement & Automation Explorer :

&1 Software

] 11 Drivers

(=¥ Remote Systems
NI-PXIG196-2FOABEEE

(&l Data Meighborhood
(x4 Devices and Interfaces
'l Scales

& software

System Monitor

Total Memory 0,98 68
Free Memory 867 MB
Total Disk Space 37,268
Free Disk Space 37,068

[ System Sattings |5 Netwark Settings

[ Halt on 1P Failure

S NI-PXIB196-2FOATBB6 - Explorer [][=0 <]

File Edit View Tools Help

= ) My System (D Restart FRefresh | 03 Set Permissions  =o Log In | 57 Hide Help |
[ Data Meighborhood —
4 Devices and Interfares — eeck. BB -~
-l seais General Settings .

Hostname NI-PXI8186-2F0ABEBS
17 Address 192.168.0.200
DNS Name NI-PXIB196-2F0ASBEE
Model PXI-8196
Serial Number 2FDABEBS
System State Connected - Running
Comments
]
Locale English

+== Connected - Running

LabVIEW Real-
Time Target
Configuration

Complets the folloving
steps fi

T
Taraet Confiquration
Tutorial

1. Bootinto LabVIEW
Real-Time

2. Configure Netwark
Settings

3. Install Software
4. Confiqure I/0

5. Confiqure System
Settings

Serial Number

pisplay rizl

number of your remote
system to provid 2
referen

to the physical
tam.

Figure 4.1 Measurement & Automation Explorer

Click on “Software”and then “Add/Remove Software”, locate “FMI to VeriStand
2011” and Install the feature:

‘o

= My System

[ Data Meighborhood
&8 Devices and Interfaces
44 Scales

& software

VI Drivers

£ Remote Systems
HI-PXI3196-2FOABEEG
[l Data Meighborhood
& Devices and Interfaces
44 Scales

& Software

| 1 nddjremove Software

Software

43 LabVIEW Real-Time Software Wizard: NI-PXI18196-2FOASBB6 (192.168.0.200)

5
t the Features to install and installed components to uninstall

= W] mational Instruments RT Software
Broadcom 57 Gigabit Ethernet Driver 3.1.0.5
%[ patasocket for Lab¥IEW Real-Time 4.7.0
X[ EPICS Server 10 Server 1.7.0
al| FMI to veristand 2011.0

10 \ariable Remote Configuration Web Servicr
Intel 1000e Ethernet Driver 2.0,0,2.2
.1

Inkel 8255 10{100Mbps Ethernet Driver 3.1.0
Lab¥IEW Control Design and Simulstion 10,0
= LabWIEW Real-Time 11,0

X
X
X Inkel 8254x Ethernet Driver 4.0.0.
X
X

%| LabVIEW PID and Fuzzy Logic Tookit 10.0.(
%| Lanauage Suppart for Japaness

% Language Support for Simplified Chinese
Microsoft Yisual Studio 2008 Runtime Suppc
Language Suppart Far LabYIEW RT 1.0.0.4
Modbus Tid Server 1.7.0

Network Streams 1,1

Network Variable Engine 1.8.0

MY Sean Fraine 2.0

al i I

~

NI Application Web Server 2.0 o

,‘7 NATIONAL

NIVS Add On Simulation Framewark.

Companent is not instalied on the remate
target,

Fvallable wersion(s) an the hast:

| S
o 7

This feature will be installed on the remote target.

INSTRUMENTS'

20110 [v|

[ Uodate pics... [ s<Badk

I

Nextx> | [ caneel | [ Hel

% Help

Figure 4.2 Install FMI Add-on on your target

nenu item. You can also access
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You have FMI support on your RT Target:

@ Software - Measurement & Automation Explorer

[BN][=1%

File Edt Wiew Tools Help
=-h My System
[@l pata neighborhood
&' Devices and Interfaces
a4 scales
& software
IVI Drivers
=¥ Remote Systems
=D NI-PXIZ196-2FDASEES
[l Data Meighborhood
&8 Devices and Interfaces
44 Scales
=) Software

31,030
I Bl FMI Lo Veristand 2011.0

Ml LabvIEW Real-Time 11,0

Ml Language Support for LabYIEW RT 1.0.0,4

M Network Yariable Engine 1.8.0

Ml NI System Canfiguration 5.0.0

Ml NI System Configuration Network Suppart 5.0.0
Ml NI Veristand RT Engine 2011,0

M8 NI Web-based Configuration and Manitaring 2.0.0
B NI-DAQX 9.4.0

M Remote Panel Server For LabVIEW RT 4.0.0

8 Run-Time Engine for Web Services 4.0.0

Ml Variable Client Support For LabVIEW RT 1.8.0

4 AddjRemove Software <

Software

Software displays the National Instruments software components installed on a LabV

W Real-Time target

What de you want to do?

ew my software information
= Install software
For more information about using your NI products, refer to your preduct-specific help, located on the Help»Help

Topics menu item. You can also access NI product help from within M&4X help, which you can launch fram the Help
menu ar by pressing <F 1=,

Submit feedback on this topic

%) Help |

Figure 4.3 FMI Add-on installed

Now you can deploy your NI VeriStand project that have FMU model in your FMU

target.
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5. Unistallation Procedure

5.1. For Windows

FMI Connection provides an uninstaller. The following steps uninstalls the FMI
Connection.

1. The uninstaller is found in the start menu. Click Uninstall to open the uninstaller
dialog.

Indirizzn | 3 Ci\Program FlestFMUtanTys | | B vai
Morne i

| Docurmentation

|Z)Examples

[Jexternal

|ZiLicense

[£] Readme. txt

unins000, dat
unins000, exe

< b

Figure 5.1 FMI Connection folder - unistall.
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6. Support

Support inquires are sent to support@dofware.com

14
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7. Dymola: Export Model as FMU

7.1. FMI for Co-Simulation

The Dymola FMU export functionality, has been extended to also support the FMI
for Co-Simulation specification version 1.0 for export of models (slaves) with built-in
numerical solvers.

The new functionality uses the SUNDIALS suite of numerical solvers (version 2.4.0).
The SUNDIALS code is not distributed with Dymola 2012, but can be downloaded
from the Sundials website (https://computation.linl.gov/casc/sundials/main.html) or
found into the \external\ folder.

To install the SUNDIALS libraries needed to activate the FMU for Co-Simulation
export functionality in Dymola, you can follow the instruction on Dymola manuals or
unzip the package "\external\sundials-2.4.0.zip" into the folder "<Dymola2012
installation folder>\Dymola 2012\Source\FMI\".

7.2. FMI for Co-Simulation generation

To generate FMU for Co-Simulation from Dymola (2012 FDO01) please follow the
instructions below:

e Go in Simulation TAB

e Simulation -> Translate ->FMU

Ty BEx
File ©dc | Simulation | Plot Animation Commands Window Help

@ HCE st | oo - CES-vOR 6 FEE DORE A £

Sp Il & Tnsate > INurmaI i = Speed: 1 v

i Simulate

Export

Variabh ¥ Continue > FMU > l Result Generation

.........

advanced |

o X

Textstyle: Preformatted + | b I W \!E == 1=\ co Ml e=|
[=true

~

=
v

Commands
]
aaaa
KRR

[ todeing | V* simuation | 4

Figure 7.1 Translate model as FMU.
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Or from your modeling tab see the image below:

Bl fulRobot_RT - RT_Robot_fullRobot_RT - [Diagram]

B[EX]

[BFe edt oo o oo Commends Window  Help

BEHASG N NOOTARL & L

Package Browser B8 x Normal
Packages Export
+ €YModelica Reference

[ kinematicPTPz
Fpathplannings

[‘g FulRobot_RT

- () Test RT_Robot

u_g_end

(EI(EJL«] » [x]

Component Browser 8 x|

Components
=RT_Robot.fulRobot_RT
Hmechanics
HlpathPlanning

axis1

H axis2

axis3

axis4
H axisS

axisé
+ McontrolBus
axisControlBus_angle_ref
- Wangle_ref
 axisControlBus_angle
Mangle
-Mu_q_end

controlBus

i

axisCortrolBust

axisCortrolBuss

axisCortrolBusd

axisControlBus3

axisControlBus2

axisCortrolBus1

pathPlanning

/N

Baxes

|

axish

axiss

axisd

axis3

axis2

axis!

]

A > | Resut Generation |
NoResulk Generation |

mechanics
5 <
5
4
3
2
el
axisControBus_. angle_ref
axisCortrolBus_.. angle
{axis1 co.

mEES

| B Modeing [V smstion |

Figure 7.2 Translate model as FMU.
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8. Import FMU in NI VeriStand

To import the FMU generated into Dymola follow the instruction below:
e Open NI VeriStand,;
e Create a New project;
e Copy your FMU into the Project folder;

e Launch the System Explorer related to a System Definition File from the
Project Explorer;

e Load the fmu model:

-

&2
File Edit Taools Help
v = | o d B o = fdd a Simulation Madel
Y =
=gl Untitled 84 & A
= Targets
Gl& = General Settings | Parameters and Signals | Inports and Qutports
i) Controller
r- g Hardware medeling environment and models (. mdl
@ Custam Devices . represent real-world
m Simulation Madels Select File or Folder E] havier of the modeled
i Execution Ord . - — neters you can )
@ XZCLII i Cercaine | I3 Untitled 82 2 J ¥ 7 - a sine wave contains
mMO = — ~ alue of the sine wave
User Channels F: Y 2 Contraller_Sourcet
i ;;a.lcu:ated Channels f g DiLogs
- imulus : orke. Tne. Simulink®
E Alarms Documenti |Z) Temporary Screen Items szirlrt;mérﬂhlg-nk =
Procedures recenti ITtestDsblock_Test i o
| g WNET Databases = |J)¥MET Raw Frame Files
i_g,_, System Channels i ﬂCUntruller_Suurcel.qu ompiling it if vou have
a2 Aliases Desktop testDsbIockﬁTest.fmu .EEEE" the h;:st .
=5 Cstanm Manpi 4 vou created using a
“agm ¥SLEM FIAPRINGS ndel be compiled
gy Data Sharing Network. - iStand supports your
-3 System Initiglization 50 -—-/ ko a DLL, .cus,
[rooumenti
- .ig
]
s
5
Rizorse del els in the configuration
computer
‘_} Mome file: Contraller_Source.fru v e errore if the
> — f o
. - - N N icn about how and
Rizorse direte | Tipa file: Simulation Moge! [ dil” fru:” lvmodBl” mdl;”. out) ]

ind click the red X button.

ok | [ P ] [ Help n tree. The Model Configuration page

For more information about adding and cenfiguring models, refer to the Configuring and Running s Praject book
of the NI WeriStand Heip, available by =electing Help»Search the NI VeriStand Help.

Figure 7.1 Import FMU.

e Save and close the System Explorer Project;

17



Open and setup the workspace from the Project Explorer;
Deploy and run the Experiment.

18



9. Getting Started

9.1.

This chapter will take you through some example in order to get you started with

Introduction

FMU to NI VeriStand Connection.

9.2. Dymolato NI VeriStand: Step by Step example

9.2.1.

9.2.2.

Prerequisites

Dymola 2012 or later
NI VeriStand 2011
FMU to NI VeriStand Connection 2011

Generated FMU in Dymola

Start Dymola:

( Dymola - Dynamic Modeling Laboratory - [Diagram] E]@
E] File  Edit Commar ds  Window  Help -8 x
EHQAS i/ OO0 ANZ & B % B ¢« 2BHEE o - B

Package Browser 5 X

Packages
+ Edrodzlica Reference

+ [(modelica

“nnamed

«  » =
Component Browser [ 4

Components

Jnname: d ]

Modeling | ¥ Simulation

Figure 9.1 Dymola.

In Dymola use “File -> Open” . Open FMUToNIVS.moe library located in your
FMUtoNIVS installation folder:
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- Indirizzo |23 CH\Program Files\FMUESNIYS201 1\ ExamplesiDymola

mo v

Frau

images

FMUToMIYS. moe
Encrypted Maodelica
QG2 KE

Figure 8.2 FMUtoNIVS Dymola example library.

( FMUToMNIVS - FMUToNIVS {Encrypted) - [Documentation]

B Fie Ede
=HaE K
Package Brawser

Packages
+ €¥odelica Reference

; Modelica

FUnnamed

NOOZARZL &

& %

FMUTalIYS

ExportToFMU

Examples

+| (CJExternallnterfaces

/1 vehicleDynamics

& /I Madelon

Component Browser

Zomponents

FMUToRIVS

Window  Help
Wz e mBABE o

Dofware Example package

Commands

F=y

i

Information

This Modelica package is intended as a caollection of examples that can be used to test the Dofware FMU to NI Yeristand add-on,
capable to add the FMU import Functionality into MIVeriStand.

Installation
This package should be used into Dymola 2012, with Sundials 2.4.0 lbrary installed.

In order to install the Sundials library package for your Dymola 2012 installation unzip the package "<Directory of Dofivare FEF Eo AT
Veristand plugin > | external| sundials-Z.4.0.zip "into the folder "<BymolaZ@12 instalfation folder> | Dymola
Z017| Sovrce | FMT| T

Usage

This package is composed by the ExportToFMU function that can be used to export the examples models using the FMI standard,
Before exporting your Dymola madels type the Following line into the dymola command line:

Advanced FML IncludeImplementationTag = true;

In order to expart your Dymala/Modelica models right click into the ExportToFMU function and choose Calf Function..., then select the
model you wank to export and the target path in which you want ko put the *.Fru File.

In order to export and test the ChassisP and YehicleTEK models you need the license for the Yehicle dynamics library from Modelon, or you
can use the already generated frou's of these models,

All the example models have been already exported in the FMI For COSimulation format, and the fmu's can be found into the Folder:
"shirectory of Dofarare FMUF Eo AT VeriStand plugin > | Examples | Dymola | AU Lfme™ .

h o

Modeling | * Simulation

Figure 9.2 Open FMUtoNIVS Dymola example library.

Expand Example folder and open one of the example listed. In this starting tutorial
| open fullRobot example:

20




[

fullRobat - FMUToHNIVS. Examples.fullRobet (Encrypted) - [Diagram] (==

H File  Edit Commands  ‘Window  Help - g x

FHAS W /OO ANL D BEFE

Be- ¢+ S HEZE % -

I < Il

Package Browser 5 X
Packages ["
E| []JExamples

@CnntmlledTanks

i eCauerLowPassanalog

|®Ful\Rohot £ L speedSensor wl

@LossyGearDemoZ B axes @—o D
@Englnela aisE W
axisControBust

@Pumplngsystem =>—|-

mechanics
@DrumBmIer
axiss

angleSensor phit

pathPlannin

=y# ChassisP axizContralBuss

b2 fvehicleTEK [v

i}&]l} ’ L] axizContraBus4 et

Cornponent Browser g X

controlBus

Components [" axisd
[CJFMUTGNIYS. Examples. fullfobot | prisControBus3

-MExample - Modelica . Icons. Example
[#Hmechanics axis?
[+ pathPlanning axizCortrolBus2

[+ axisl
[+axisz
[#laxis3 axisControBus1
[+laxis4
[
e
[t
[t
[t

—= MW B ;M om

axis]

¥l axiss
Hlaxist
| Ml controlBus
HlangleSensor
H|speedSensor
W phit A

| Modeling ‘I Simulation

Figure 9.3 fullRobot example.

For use models in the example library you have to duplicate it.
Duplicate fullRobot Class:

( MUTGNIVS - FMUTGNIVS (Encrypted) - [Documentation] =JoEd
n Fils  Edit Commands  MWindow  Help -8 x
BEHAE R /OO0 ANZL S EFE -4y mAEBE 0o - & 945
Package Browser & x| Dofware Example package e
~
Packages [ Information
(1 ExportTaFMU
This Modelica package is inkended as a collection of examples that can be used to test the Dofware FMU to NI ¥eriStand add-on,
capable to add the FMU import Functionality inko MIVeriStand.
@Control\edTaan
Installation
- (¥ H_auerLowPassAnalog
:®FUIIF i This package should be used into Dymola 2012, with Sundials 2,4.0 library installed,
E ] Open Class in This Window
- @Luss order ko install the Sundials ibrary package for your Dymola 2012 installation unzip the package "<Directory of Dofware FMU to AT | =
@E Open Class in New WiNdow oy and plugin > | external| sundials-2.4.0.zip "into the folder "<DymolaZ012 installation folder> | Bymoia
M e »
@Pun’ A
@Dru\ e h
o ch Q| search.., Duplicate Class sport ToFMU Function that can be used to export the examples models using the FMI standard,
- 3
Close Extend Fram... " "
= els type the Following line into the dymola command line:
B LE v
fionTag = true;
Companent Bro 4
In order ko export your DymolafModelica models right click into the Export ToFMU function and choose Calf Function..., then select the
.Cumpunsnts model you want ta export and the target path in which you want ko put the *,Frou File,
“FMUTNIYS
In order to export and test the ChassisP and YehicleTEK models you need the license For the Yehicle dynamics library From Madelon, or you
can use the already generated Fru's of these models.
Allthe example models have been already exported in the FMI for COSimulation format, and the Fmu's can be Found into the Folder:
"“firectory of Dofware AU o AT VeriStand plugin > | Examples | Dymoda | 2400 * fmu ™.
-
FMUToMNIYS | & modsling | ¥ Smuiation

Figure 9.4 Duplicate fullRobot class.

Select Duplicate fullRobot model and check this class:
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( ullRebot - fullRobot - [Diagram]

N=x)

l=] File Edit  Smolstion Flob Apimstion Commands  Window  Help

BHQAS N S/ O00FARZL B-HR

G- ¢ BEAEE o -

=k

& WO @

Package Browser g x

Packages
&+ €WModelica Reference
B [ Jmededica
~Unnamed
= ] FMUToNIYS

- (T JExpartToFmu
E| Examples
[+ [CJExternallnterfaces
& /I vehicleDynamics
&/l Modelon

|

(R lEle) » [K]

Component Browser (=

Zomponents
Efullrabat
IRExample - Modelica [cons, Example
[+ mechanics
[+ pathPlanning
[+ axisl
[Haxis2
[+ axis3
[+ axis4
[+ axisG
[+ axist
WcontrolBus
HangleSensor
[+ speedSensor
Mohil

controlBus

axisCortrolBust

axisControlBuss

axisCortrolBus4

axisControlBus3

axisCortrolBusZ

axisControlBus1

angleSensor Bhil

pathPlanning

L SN

B axes

speedSensor wl

axish

mechanics

axiss

axisd

axisd

—= M W = M om

axis?

axizl

I Modeling W simulation

Figure 9.5 Check fullRobot model.

Go in Simulation Tab and setup your experiment and Simulate it:

ullRobot - fullRebot xperiment Setup m
File Edf  Simulabion  Plot  Animation  Commands — Window  Help 1 ‘ ” ” " "
General Translation Cubput Debug Campiler Realtime
: H 1 = =
EEHAS N ieE o - 2yvaina FERTE0
5 Experirnent
kIl 4 AL P Time: 00999 —— cpeed: 1 -~
Mame |fu||RDbut |
Variable Browser J X
»
Yariables | values ~ E Plot [1%] Sirmulation inkerval
HfullRobot 1 . | |
Sfulrabt 2 Start time |0
-Crload Stop time 20 |
-[Jg 9.61
~[JrefSwingTime Output interval
[Cstartanglel
[startangle2 (& Interval length ‘0.01 |
Dstartangle3 ) Mumber of intervals ‘U |
~[startAngled
-[IstartAngles -110 Intagration
-[IstartAngled
~[Jendanglel Algorithrm |Dass| Ill
[Cendanglez
Clenddangles Tolerance |D.Dl |
-Clendangles Fixed Integrator Step |U |
-[lendangles 110
-[lendanglet
~[refSpeedMax(1]
< T |
I Advanced
X | Text style:  Custom - Il:l i u i =l e=
-]
= true
simulateModel (" fullRobot ", stopTime=20, number0fIntervals=0, outputInte:
= false
gimulateModel ("fullRobot", stopTime=20, numberOfIntervals=0, outputInte:
H|| = true
5
= <] & QK ][Stureinmudel] [ Cancel ]
g

Modeling | VW Simulation

Figure 9.6 Setup the experiment.
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Generate FMU for co-simulation

fullRobot_RT - RT_Robot.fullRobot_RT - [Diagram] E]@
B e ear A Commands  wWindow _Help =E
BEHAS N /)OO ARL - T Z- B¢ 2EHEEZ v - e- v aa

Package Browser ) & X Normal

Packages Export

4 €9Modelica Reference FMU » Result Generation

4 [Jrodeiics No Result Generation

pathPlanning

fSipathPlannings /_\
i.& fulRobot RT 6 axes

" (B)Test_RT_Robot

(.

axish
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Figure 9.7 export FMU.

Now you have the “FMUToNIVS_Examples_fullRobot.fmu” file:

._'J ._'_J __'_j

binaries FML images buildlog. kxt
=2 B B 4
dsfinal. bt dsin.bxt dslog.txt dsmodel.c
T &)
dsmodel_F...  dymosim.dl  dymosim.exe  dymosim,exp

8 0 = B

dymosim,lib - FriModellde, .. FMUToMIVS... FMUToNIYS_E

xamples_fullR

obot. Fru
fulRobot.mat - modelDescri. ..

[}

Figure 9.8 FMU file.

Now you can use FMUToNIVS_Examples_fullRobot.fmu in VeriStand.
Open NI VeriStand 2011 and create a new project:
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R4 Getting Started Window | (=] .}\_}'\J

File Tools Help

%] New NI VeriStand Project News
SN -0nfor Real-Time Test Cells
Most IT g
_ W Create New Project %) ez
| Project I System Defintion “ Properties EcoCAR Competition
Project Name Exchange
l,U,ntitlecLl - . o o o o - - ‘ veloper's Guide
[N sEriees oo ok Bl Bl Rl Bl B R R COR Chialienge
; | Ci\HIL\National InstrumentsiProjects ‘ =l
Active ‘ |
— Create folder for project
u : istand
Project Eath B - B B - B - - )
:I | C:\HILYNational InstrumentsiProjectsiUntitled 1Untitled 1.nivsproj [ NI VeriStand

[

[ Cancel ] Help

Figure 9.9 Open NI VeriStand and create a new project.

Copy in the folder project ( C:\HIL\National Instruments\Projects ) the
FMUTONIVS_Examples_fullRobot.fmu file:

: Inditizzo |[ﬁ CiYHILYMational InstrumentsProjectsiUntitled 1 t]
Logs HKMET Raw Untitled Untitled nkitled
Frame Files 1.nivsproj 1.nivsscreen 1.nivssdf

B

FMUToMIYS_E
xamples_Fullr
obot, Friu

Figure 9.10 .fmu file in your project folder
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Open System Explorer:

g System Explorer - Untitled 1.nivssdf B 0

Fle Edt Toos Help

BEH & # B A -0 Add & Smulation Modsl

i=+ligll Untitled 1
% Targets
rif) Contraller Models
B Hardware Medels contains your compiled medels you created in any supported medeling envirenment and models (Lxdl
b @ Custom Devices files) you created using The MathWorks, Inc. Simulink® software. Models mathematically represent real-world
E‘J‘ Simulation Models systems. A medel responds to stimuli by producing cutputs in @ way that emulates the behavior of the modeled
1 @ Execution Order item. Models contain inputs and cutputs that send and receive data. Models contain parameters you can
S manipulate and signals whose valuss you can view. For sxample, a model that generates a sine wave contains
il Fiodels parameters that adjust the amplitude and frequency of the sine wave. You can view the value of the sine wave
-4 User Charnels using the model signal.
L f Calculated Channels
e SIS You can build madels using several different modeling environments, including The MathWorks, Inc. Simulink®
@ Marms application software, Esterel SCADE Suite™ software, TESIS DYNAware software, MATRIXx™ SystemBuild™
Procedures software, and the LabWIEW Development System.

HNET Databases
System Channels

You can run a model (.xd1) you created in the Simulink simulation environment without compiling it if you have
a2 Aliases The Mathworks, Inc. MATLAS® and Simulink software installed on your computer. In thl% case, the host
- ) computer alse must be the exseution hest. Yeu enly can run an uncempiled medel (.=a1) you created using a
o System Mappings computer running the Windows operating system because NI VeriStand requires that 3 model be compiled

Data Sharing Metwork. before it can run on an RT target. & compiled model also can run on a desktep PC. NI VeriStand supports your
13 System Initslizatior, cempiled medels frem any medeling envirenment that enables you to compile a medel inte a OLL, . aut,
or . lvmodel file.

What do you want to do?

Add a model

To add a model, click the Add a Simulation Model button. You also can right-click Medels in the configuration
tree and select Add Simulation Model from the shortcut menu.

Note Adding mare than ane instance of the same compiled model can cause errors if the
compiled model has dependencies. Contact your madel vendar for infarmation about how and
when these errers can ceeur.

Remove a model

To remeve a model, select the medel name in the cenfiguratien tree and click the red X button.

View or change a model

To view or change a model, select the model name in the configuration tree. The Model Configuration page
appears to the right of the configuration tree.

For more information about adding and configuring models, refer to the Configuring and Running 5 Project book
of the NI Veristand Help, available by selecting Help»Search the NI VeriStand Help.

>

Figure 9.11 System Explorer

Specify the target, in this example | select a PXI target:

‘%Syslﬂm Explorer - Untitled 1.nivssdf® =

Fle Edt ool Help

BOSH| X aEL B

= - Untitled 1
3 Targets Targets
i AL Aliases J
=32 System Mappings Targets contains any targets you add.

% Data Sharing Network.
L3 System Initialization

What do you want to do?
g Add Target

can right-click Targets in the cenfiguration
Target name

PXI
1P Address

(G ST and click the Delete button. Deleting a target

Pharlap (] 192,168.0.200

Description

ok | [ cawd | [ Help

Figure 9.12 Define RT Target
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Open your fmu model in your project folder:

R&L System Exp

rer - Untitled 1.nivssdf

File Edit Tools Help

o H S

# B A

= Add a Simulation Made!

=g Untitled 1

E—J% Targets

(i Controller

= Hardware

[y) Custom Devices
=fif Simulation Madels

| @ Execution Order
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w User Channels

Fr Caloulated Channels
- g SHiMILILS
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Pracedures

g XMET Databases

? System Channels

- 23 Aliases

- =9= System Mappings

-y 1y Data Sharing Network

3 System Initislization

il
R&t Add Simulation Model

General | Settings " Parameters and Signals ” Inports and Outports

Marne

IE]

| medeling environment and models (.mdl
dels mathematically represent real-world
chat emulates the behavior of the medeled
1odels contain parameters you can

rodel that generates a sine wave contains

Select File or Folder

Cerca in: ‘ (£ Untitled 1

& © & =@

Path

Y CLogs

[C)=MET Raw Frame Files

Diocumenti MUTONIYS_Examples_fullrabat, frou
recent
MIveriStandServer Port (MDLs on| —
a012 @
Desktop

Simulation model info

Documenti

Riisorse del
CompLker

~
Q Mome file:
Risorse direte  Tipo files

FMUToMIVS_Examples_fullRobot.fru "I Ok

3n tree. The Model Configuration page

he Configuring and Running & Project book
I VeriStand Help. —

Figure 9.13 Load fmu model
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Your model in VeriStand:

f5- System Explorer - Untitled 1.nivssdf

Eile Edt TIools Help

meEWH | % X | B A
=gl Unititled L Model Specification
=53y Targets
=il Contraller Marne

+-Em Hardware FMUToNIYS_Fxamples_fullRobaot

[} Custom Devices

—-m Simulation Maodels Descripkion
@ Execution Order
=il Models

- FMUTOMIVS_Examples_fulRobot
+-7) Execution
-3 Inparts
=3 Outports

- T phit

T wi

Parameters Model Settings
B Signals

{8 User Channels
v Calculated Channels Initial state running Decimation Rate [Hz]
Ao Stimulus ® 1 100 Auta Select Decimation
@ Alarms

Procedures Initial state paused Simulation model processor

¥MET Databases Automatic P -2

&-3? System Channels
- #p Aliases
x System Mappings
gty Data Sharing Network. )
53 System Initislization Simulation mods! info
Model rate: 100 Hz

Model Information

Path: C:\HILYNational InstrumentsiPrajectsiUntitled 1\FMUTANIYS_Examples_FulRabot.Fmu
Modification date/time: 14,16,48,000 19/01/2012

File size (Byte): 362186

File wersion:

Product narme:

Internal name:

Company name:

Legal copyright:

File description:

Figure 9.14 fmu model in VeriStand

Save your model, close System Explorer and in the Project Explorer run the
project ( Operate > Run ).

44 Running Project

Running Praject C:4HILYNational Instruments' Projects',Untitled 15\Untitled 1.nivsproj

‘eristand Gateway Status

« Loading Swstem Definition file: C:YHILYMational InstrumentsiProjectsiUntitled 1iUntitled 1.nivssdf | s
+ Prepating to deploy the Systen Definition ko the targets, ..

+ Compiling the System Definition file, ..

« Starting YeriStand PC Engines. ..

+ Initiglizing TCP subsystem. ..

+ Starking TCP Loops...

« Connection established with target Contraller.

+ Sending reset command ko all targets. ..

« Freparing to deploy files to the targets, .,

« Starting deployment group 1...

+ Target Controller is online,

« Deplovment group 1 is ready,

« Preparing to synchronize with targets. ..

+ CQuuerying the active System Definition file from the targets, ..
« Target synchronization complete.

System Definition successfully deployed,

[ close an successful deployment

Figure 9.15 Running Project




In the Workspace you can view your variable:

R

Fle Tooks Screen View Window Help

| |=# | Screen M1 oof 1

Graph

Hide Legend
Hold

Workspare Controls

& Graph Channel Selection

25+
o-
. General | Format & Precision
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7,5+ Graph n 1 2l mioz = 10,0 2 |ShHz ~
-0 7] Allow Resize?
00:00
Leqgand Text Wariahle ~
phil Targets/Controller/Simulation ModelsfModels/FMLTONT
i} Unitied 1 wi Targets/Contraller/Simulation ModelsiModels/FMUTONT
2 Targets
=l Controller
= i Simulztion Models
= il Models
= = FMUToNIVS_Examples_full Robot
# () Execution
= 3 Outports
T ehit
Iw
® 27 System Channels
< > -

Figure 9.16 Load your model info
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Figure 9.17 Your model deployed on RT Target
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